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1.0	 MC20-D2 DATA LOGGER RETROFIT

1.1	 Unpacking and Inspection
Your MC20-D2 Data Logger is engineered to be a highly reliable, accurate system.  It has been systematically assembled, 
inspected, tested and calibrated; then carefully packed or installed on your new McCrometer flowmeter before shipment.  If 
not installed, unpack the data logger carefully and inspect each assembly thoroughly for obvious shipping damage (Figure 
1).  Notify the freight carrier immediately upon discovery of any damage.

Make sure that all parts are included in the shipment listed below:

•	 MC20-D2 Assembly
•	 Specification Sheet
•	 EH222-10 Installation Kit, containing:

•	 D0100-1.5	 Cable Extension				    1 each
•	 10142-20	 Screw 10-32 x 3” Long w/ Seal Hole	 1 each
•	 10142-30	 Screw 10-32 x 2-3/4” Long			  5 each
•	 10285	 O-Ring 3-5/8” OD				   2 each
•	 10013-00	 Dry Pack, Silica Gel			   1

Figure 1. MC20-D2 Data Logger

Circuit Board

Water-Tight 
Strain Relief

Aluminum 
Housing

Magnet Assembly

MC20-D2 Data Logger Retrofit
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1.2	 Disassembly
It is necessary to remove the existing canopy and register.  The data logger mounts between the register and the register 
mounting plate already installed on top of the pipe protruding from the top of the meter.

THE FLOWMETER CAN BE IN FULL OPERATION DURING THIS PROCEDURE.

MOUNTING PLATE

MECHANICAL REGISTER

CANOPY

PAL NUT

O-RING

You can now see the open end of the ell with the drive 
cable. (Figure 3) If the flowmeter is in operation the cable 
will be rotating. 

If the flowmeter is not installed, turn the propeller by hand 
to check that the bearing and cable rotate freely.

If the meter is installed but not running, turn the drive cable 
with your hands. The drive cable may be difficult to reach 
with your fingers, and you may need to use pliers. If you feel 
resistance, the cable and propeller are properly attached. If 
the pipe is full of water, the cable may be difficult to turn.

DRIVE CABLE

!
CAUTION

Protect the register from dust while it is 
outside of the canopy.

Figure 2. Canopy, Register Removal

Figure 3. Location of The Drive Cable

1.2.1	 Canopy Removal

Remove the six screws holding the canopy to the mounting 
plate and discard, Figure 2.  One of the screws has a seal 
attached, remove it prior to removing that screw.  Lift off 
the canopy  slowly, straight up to prevent damage to the 
register.

1.2.2	 Register Removal

Loosen the pal nut located on the threaded shaft of the 
register.  Carefully unscrew the register counter clockwise 
and lift it from the bushing. Remove the O-ring and discard 
it.

MC20-D2 Data Logger Retrofit
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MOUNTING PLATE 

O - RING 

DATA LOGGER 

MECHANICAL REGISTER

CANOPY

DATA LOGGER

O - RING

SCREW

HOLE FOR
ANTI-TAMPER SEAL

MOUNTING PLATE

1.3.1	 Data Logger Installation

1.	 Place an O-ring over the lip on the mounting plate as 
shown in Figure 4. Use a small amount of silicone grease 
to lubricate the O-ring.

2.	 Rotate the data logger to align the wire leads to the 
desired position.

3.	 Lower the data logger to insert the cable  into the 
center shaft of the data logger.

4.	 Continue to lower the unit until it touches the O-ring on 
the plate. Work the data logger carefully down over the 
O-ring, seat it firmly into place.

Note: Proper alignment of the O-ring on the base plate can 
prevent damage to the O-ring.

1.3.2	 Register Installation

1.	 Find the short cable extension in the installation kit and 
insert it into the center of the bearing on top of the data 
logger.

2.	 Place the register with the pal nut still in place on the 
cable extension and rotate it clockwise three or four 
turns. Stop when the register is positioned as it was 
prior to its removal and tighten the pal nut until it is 
snug.

3.	 If the flowmeter is operating, turn the register in until 
there is a slight binding of the cable in the register and 
then back out approximately two turns and then tighten 
the pal nut. This should give you smooth operation and  
the register should be correctly positioned.

1.3.3	 Canopy Installation

1.	 Place an O-ring in the groove on top of the data logger.  
Use a small amount of silicone grease to lubricate the 
O-ring.

2.	 Place the canopy on top of the data logger.

3.	 Orient the canopy so that the lid of the register opens 
in a direction that is most convenient for the register to 
be read, with the lid hinge at the 12 o’clock position of 
the register.

4.	 Lower the canopy carefully over the lubricated O-ring 
and seat it firmly onto the data logger housing. (Figure 
5)

5.	 Align the screw holes of the canopy with the screw 
channels of the data logger and with the threaded 
screw holes of the base plate.

6.	 Locate the long screws; insert the screws through the 
canopy, data logger housing, and the plate.

Figure 4. Installation Of The Data Logger

Figure 5. Canopy Installation

7.	 Tighten the screws using the crisscross method.  Use 
caution when tightening the screws to prevent thread 
damage. The O-rings will seal the data logger and 
mechanical register from environmental contaminants.

8.	 Insert the anti-tamper seal through the hole in the 
security screw and attach the seal.

1.3	 Re-assembly

MC20-D2 Data Logger Retrofit
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2.0	 DATA LOGGER SOFTWARE REQUIREMENTS
Thank you for your purchase of the Mc® Propeller Data Logger.  The Mc Propeller Data Logger uses the Madgetech 4 Data 
Logging Software.  This manual will guide you through the installation and operation of the data logger software.

MadgeTech 4 Data Logging Software requires an IBM or compatible PC with the following:

•	 PC-compatible Pentium-class system

•	 Windows XP/Vista/Windows 7 (32 and 64 bit), Windows 8, and Windows 10

•	 Color SVGA monitor (1024 x 768 resolution)

•	 1 GB (or more) RAM

•	 At least 30MB free hard disk space (for installation)

•	 Available USB port (for USB logger interface cable)

(Note: Although the software is designed to work with the Windows Operating Systems listed above, MadgeTech cannot 
guarantee operation on Operating Systems no longer supported by Microsoft’s Support Life Cycle Policy.)

3.0	 SOFTWARE INSTALLATION
The MadgeTech 4 Standard Software is located on the flash drive provided with your system, or it can be downloaded from 
the MadgeTech website:  http://www.madgetech.com/software-download.

3.1	 Installing The Software From The Included Flash Drive
To install the MadgeTech software from a flash drive:

1.	 Insert the flash drive labeled MadgeTech Data Logger Software Version 4.X.X into an available USB port.  After a few 
moments an Autoplay box will open. (Figure 6)

Figure 6. Autoplay Screen

data logger software requirements
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2.	 In the Autoplay box, click Open folder to view files to view the contents of the flash drive.

3.	 In the event that Autoplay is disabled, manually browse to the MadgeTech flash drive by clicking on the Start button or 
Windows Icon, navigate to Computer and double click the drive, MadgeTech4, to view the contents of the flash drive.

4.	 Once in the MadgeTech 4 file location, locate the exectuable file “autorun.exe”.  (Figure 7) Double-click “autorun.exe” to 
launch the MadgeTech 4 Installer Options.

Figure 7. MadgeTech 4 Autorun File

Figure 8. MadgeTech 4 Software Selections

5.	 The MadgeTech installer Options screen will appear.  (Figure 8)

6.	 Click MadgeTech Software to open the Install MadgeTech Software options page.

Software Installation
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7.	 The MadgeTech 4 Software requires the .Net 4.0 Framework to be installed on the intended PC. (Figure 9) The Windows 
8 operating system comes with the 4.5 .Net Framework already installed. If the .Net 4.0 Framework has not been 
installed on the PC, click the Install .Net 4.0 Framework option and follow the wizard installation steps.

Figure 10. Software Installation Windows

Figure 9. MadgeTech 4 Software Installation

When the Installation Complete screen appears, click Close to exit the wizard and return to the autorun, then Exit at the 
bottom to close the autorun. The MadgeTech 4 Standard Software is now installed on your PC.

NOTE: If the .Net 4.0 Framework has already been installed and you attempt to run the Install .Net 4.0 Framework, 
a window asking to Repair or Remove the .Net 4.0 Framework will appear. It is recommended to select the 
Cancel button when this page appears.i

8.	 After the .Net 4.0 Framework installation has been confirmed, click the Install MadgeTech Software option. Select 
English when prompted for a language selection, then the Installation Wizard will walk through the installation steps 
to install the software.

Figure 10 shows examples of the installation windows:

Software Installation
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3.2	 Installing The USB Interface Drivers
The USB interface drivers can easily be installed on the PC if they are not already available and running. From the MadgeTech 
Installer Options page, click Drivers and Third Party Tools to open the MadgeTech Device Drivers and Third Party Tools page.   
Then click Install USB Interface Drivers. (Figure 11)

Figure 11. USB Interface Drivers Installation Selection Window

Figure 12. USB Interface Drivers Installation Windows

The Datalogger Interface Driver Installer dialog box will appear. Click Install to start the driver installation. A dialog box will 
appear when installation is finished. (Figure 12)

Software Installation
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4.0	 CONNECTING THE MC20-D2 DATA LOGGER

4.1	 Start the Data Logger Program

Figure 13. The MadgeTech 4 Opening Screen

4.2	 Program Menus and Navigation

FILE 
DATABASE 

PANEL

CONNECTED DEVICES AND FILES PANEL

GRAPH DISPLAY PANEL

CHANNELS 
PANEL

Tab Options Menu Bar (changes depending 
upon the selected tab) Help Button

Figure 14. The MadgeTech 4 Panel And Menu Descriptions

When you start the program, 
you will see the main screen, 
with the Device tab selected 
by default. (Figure 13)

Figure 14 shows the 
different panels on the 
Device tab.

A full description of each 
command with the menu 
bar will be explained 
briefly in section 5.3.

NOTE
No devices are shown 
to be connected in 

the figure at right. You can 
connect the USB cable 
to the data logger either 
before or after you start the 
program. 

i

Connecting the MC20-D2 Data logger
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4.3	 Connect the Data Logger to the Computer

4.	 Plug the other end of the 3.5mm cable into the 
MC20-D2.

2.	 Plug the 3.5mm cable into the rear of the IFC200 USB 
dongle.

3.	 Plug the IFC200 USB into the computer.

5.	 Once the software has opened, it will take a few moments for the devices to show up under Connected Devices.

1.	 If it is not already running, start the MadgeTech 4 
program.

Connecting the MC20-D2 Data logger
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5.0	 PROGRAM FUNCTIONS AND COMMANDS

5.1	 File Tab Commands
The tab titled “File” contains several options. (Figure 15) Below is a brief description of each item. 

Figure 15. File Tab Contents

New: Creates a new blank report

Open: Opens a report saved 
outside the software

Save: Saves the file to the file database

Save To: Saves reports as an MTFF file

Import Files: Imports files from 
locations outside of the software

Import Folder: Imports folders from 
locations outside of the software

Print: Prints the selected open report

Close: Closes the selected open report

Recent Documents: The side bar will 
show any recent documents that have 

been opened or saved

Options: Many software 
settings and defaults can 
be managed and edited 

here (see Section 5.2)

Exit Application: 
Closes the software

Program functions and commands
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5.2	 Options Screen Commands
The Options button offers a variety of options that affect the appearance and default settings of the program. (Figure 16) 
Following is a description of the functionality of each of the available options:

Figure 16. Options Screen

Device Change device settings of a logger in regards to calibration notifications and importing 
engineering units from the currently connected devices.

Display Edit the default settings when the software opens.
•	 Page display allows the user to choose what measurement the page display can be: Inches, 

Millimeters or Centimeters.
•	 Viewing data allows the user to edit the time format and channel grouping.

•	 Cooling flags allows the user to choose the default cooling flags that can be displayed.

•	 The Layout section allows the user to edit the ability to minimize to the system tray, the overall 
software color scheme, and resetting the screen layout.

File Change how files are imported and where the preferences and file database are located.

Graph Change the default graph properties.

Units Change the default colors for the various unit types.

Address Book Manage the contacts within the software.

Email Settings Manage the server address, port and email authentication settings.

Communications Configure and display detected interfaces.

Reporting Change the software problem and usage reporting preferences.

Wireless Configure the timeouts of wireless timeouts.

Program functions and commands
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Figure 17. The Device Menu Screen

Control section

1 Custom Start Start the selected device(s) using custom settings

2 Quick Start Start the selected device(s) using current settings

3 Real Time Start Start the selected device(s) in real-time mode

4 Batch Start Automatically start devices of the same type as they are connected

5 Stop Stops the selected device(s)

6 Download Download recorded data from the selected devices

7 Reset Resets the selected device(s)

8 Workflows Manage device automation workflows

9 Enable Cloud Monitoring Add the selected devices to the cloud monitoring system

10 Disable Cloud Monitoring Remove the selected devices to the cloud monitoring system

11 View Cloud Data View cloud data in a web browser

12 Download Cloud Data Download cloud data

Alarms section

13 Manage Rules Manage Rules:  Manage Real-time alarm rules.

14 Alarm Log Alarm Log:  Displays past alarm notifications.

Information section

15 Properties View the properties and settings of the selected device.

16 Engineering Units Manage engineering units.

Wireless section

17 Claim Add the selected wireless device(s) to the network.

18 Release Remove the selected wireless device(s) from the network.

19 Locate Find or identify a wireless device with an audible alarm.

Information WirelessControl Alarms

5 6 7 83 42 9 10 11 12 13 14 15 16 17 18 191

5.3	 Device Tab Commands
The Device tab, located at the top of the menu bar, contains all of the features for managing devices. (Figure 17) Within this 
tab are four different sections: Control, Alarms, Information, and Wireless.  Below is a list of commands and options found 
in the device menu.

Program functions and commands
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Graph section
1 Generate Generates a graph based on the current report, or a blank graph if no report is open.
2 Select Change the cursor function to select data points.
3 Fit to View Zoom out to fit all data In view.
4 Box Zoom Change the cursor function to zoom in on a selected area.
5 Horizontal Zoom Change the cursor function to zoom in on a selected length of time.
6 Vertical Zoom Change the cursor function to zoom in on a selected unit range.
7 Set Scale Set the scale of the graph.
8 Lock Vertical Scale Lock the vertical scale of the graph.
9 Enable Autoscroll Allow the graph to automatically scroll along the time axis as Real Time data points are added.

10 Axis Positions Change which side of the graph each axis is positioned.
11 Timeslice Manage timeslice options.
12 Cooling Flags Set annotations for multiple temperature cooling points.
13 Value Lines Horizontal lines that are fixed for Minimum, Maximum & Average Line values.
14 Line Thickness Changes the thickness of the value lines in the graph.

•	 Line Color - Changes the color of the value lines in the graph.
•	 Background Color - Changes the background color of the graph.

Data Table section
15 Generate Generate a new grid based on the current report, or a blank grid if no report is open.

Statistics section
16 Generate Generate a new statistics view based on the current report, or a blank view if no report is open.
17 Add / Remove Manage custom statistic information.

Channels & Readings section
18 Time Markers Allows graphs to be displayed with cycle duration properties.
19 Device Properties View the properties of the selected channel’s associated device.
20 Math Channels Manage channels that generate values based on specified calculations.
21 Remove Channels Remove the selected channel from the current report.
22 Add Annotation Add a comment to the graph.

•	 Unit - Change the unit for the selected channel.
•	 Channel Grouping - Change how the channels are grouped; Serial Number, Device ID and 

Device name.

Report Options section
23 Report Properties View details about the current report.
24 Export to Excel Copy the data of the current report to Microsoft Excel®.

Figure 18. The Report Menu Screen

1

Statistics Channels & Readings Report 
Options

Graph Data 
Table

5 86 93 4 72 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24

5.4	 Report Tab Commands
The Report tab, located at the top of the menu bar, contains all of the features and options for managing reports. (Figure 
18) Within this tab are five sections: Graph, Data Table, Statistics, Channels & Readings, and Report Options. Below is a list 
of commands and options found in the report menu.

Program functions and commands
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6.0	 DOWNLOADING DATA
When the data logger is recording data, it stores the readings in its internal memory.  To view the data, it must be downloaded 
from the device and viewed as a graph, a data table, or statistics report in the MadgeTech software. Downloaded data will 
remain stored on the device until the device is reset or restarted. 

NOTE: The MadgeTech Software will not download the same data more than once.

6.1	 Download From A Device
To Download Data from a device:

1.	 In the Connected devices panel, select the intended device to download data from.
2.	 On the Device tab, in the Control group, click Download. Users can also right-click the device and select Download 

in the context menu.

6.2	 Automatically Display Reports of Data that have just been Downloaded
The user can also choose to have reports automatically appear to 
display data that have just been downloaded. (Figure 19)

To configure the appearance of reports:

1.	 Click the File tab, then click Options.
2.	 From the Options screen, click Display.
3.	 In the Viewing Data section, select the check box next to each 

report type the user wants to automatically open when data 
is downloaded from a device.

6.3	 Download While Recording
Certain devices have the ability to download data in the software 
while recording. The reading interval must be two seconds or slower, 
and the memory wraparound must be disabled.

To download data while the device is still recording:

1.	 In the Connected devices panel, select the intended device to download data from. Confirm the intended device 
has been selected by making sure the device is highlighted.

2.	 On the Device tab, in the Control group, click Download. To the right is an example of the following dialog box that 
will appear, asking to stop the device from recording.

3.	 Click Yes to stop the data logger and download the data. Click No to download the data and have the data logger 
continue to record. Click Cancel to neither stop the device nor download any data.  McCrometer recommends 
selecting “No” when asked  to stop the data logger. (Figure 20)

Figure 19. Menu To Configure The 
Appearance Of Reports

Figure 20. Stop Before Downloading Dialogue Box

IMPORTANT
If the data logger is stopped while downloading 
data it must be restarted again using the device tab.

IMPORTANT
if the data logger is stopped while downloading 
data all stored/logged data on the data logger will 
be deleted once the data logger is restarted.

i
i

DOWNLOADING DATA
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Figure 21. Exporting data to Excel

7.0	 INTERFACE CABLES
Check that the software recognizes the interface cable. If a device is not appearing in the Connected Devices panel, it may 
be that the interface cable is not properly connected.

7.1	 Check That The Software Recognizes The 
Interface Cable

To check that the software recognizes the interface cable:

1.	 In the software, click the File button, and then click 
Options.

2.	 In the Options window, click the Communications 
tab. (Figure 22)

3.	 The Detected Interfaces box will list all of the 
available communication interfaces. If an interface 
cable is listed, the software has correctly recognized 
it and is ready to be used.

6.4	 Export Data to Excel Format
For the purpose of this instruction, use the sample data in the Example Datasets folder.

1.	 Select the Report tab.

2.	 In the File Database panel, select the Example Datasets folder.  A list of sample datasets will be listed in the Connected 
Devices and Files panel.

3.	 Select the dataset you want to export and double click on it. A graph of the data will appear in the Graph Display Panel.

4.	 Select Report Options and then select Export to Excel.

5.	 When the dialog box asking if you want the exported spreadsheet to include a graph, select your preference. The first 
tab of the spreadsheet will resemble the graph displayed in the Graph Display Panel.

The data will be exported to a spreadsheet and your spreadsheet program will open. If you are satisfied with the exported 
data, save the file with a new file name.

1 4

2

3

Figure 22. Communication Window

INTERFACE CABLES
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7.2	 Check that Windows Recognizes the Interface Cable
If the software does not recognize the interface cable, there may be a problem with Windows or the USB drivers.

To check that Windows recognizes the interface cable:

1.	 On the Windows desktop, click Start, right-click Computer and choose Properties. 

2.	 Click Device Manager.

3.	 In the File > Options window of the MadgeTech software, click Communications.  Depending on the type of 
interface cable in use, choose one of the following steps accordingly:

•	 Interface cables that use MadgeTech drivers: (old IFC200, IFC300, IFC400, RFC1000 

1.	 Click Universal Serial Bus Controllers.

2.	 Look for an entry for Data Logger Interface.

•	 If the entry is present, and there are no warning messages or icons, then windows has correctly recognized 
the interface cable.

•	 If the entry is not present, or has an exclamation point icon next to it, USB drivers may need to be installed.

•	 Interface cables that use Windows drivers: (new IFC200/202 

1.	 In the Windows Device Manager, click Human Interface Devices.

2.	 Look for one or more entries listed as HID-compliant device. If there are no entries, Windows has not 
recognized the interface cable.

3.	 Right click the entry and choose Properties.

4.	 In the Properties window click the Details tab.

5.	 From the Property combination box, choose the Hardware ID’s item.

6.	 Verify that the Hardware ID string HID/VID_10C4&PID_8748 is present.

•	 If the entry is present, and there are no warning messages or icons, then windows has correctly recognized the interface 
cable.

•	 If the entry is not present, or has an exclamation point icon next to it, USB drivers may need to be installed.

7.3	 Ensure that the USB end of the Interface Cable is Securely Connected to the Computer
To ensure that the USB end of the interface cable is securely connected to the computer:

1.	 Identify the type of interface cable being used.

2.	 Locate the USB-A plug of the interface cable.

3.	 If the interface cable is connected to the PC, unplug it.

4.	 Wait ten seconds, and then reinsert it.

5.	 Check to make sure that the blue LED is lit, indicating a successful connection.

INTERFACE CABLES
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1.	 Right click on the device and select Apply 
Engineering Unit.

NOTE: The engineering unit is the unit 
of measure the flow meter will measure 
water flow. To select and apply the 
engineering unit, you will need to know 
particular ratio of pulses per gallon 
for your flow meter. If you do not have 
that information contact McCrometer 
technical support.

8.0	 SETTING UP THE ENGINEERING UNIT

8.1	 Selecting an Existing Unit of Measure
The Engineering Unit refers to the unit of measure you will record your water flow in. If you want to record your measurement 
in units other than the default, follow these steps to either select an existing unit of measure or to create a custom unit.

2.	 Window will open that will allow you to create your 
own unit. Select Volume and then next.

3.	 Select Gallons (gal) as the destination unit.

Note: If your flow 
meter uses a unit 
not listed below, 
go to section 8.2.

Setting Up the Engineering Unit

Copyright © 2016-2018 McCrometer, Inc. All printed material should not be changed or altered without permission of McCrometer. Any 
published technical data and instructions are subject to change without notice. Contact your McCrometer representative for current technical 
data and instructions.  Mc® of Mc Propeller is a registered trademark of McCrometer, Inc.  MadgeTech is a trademark of MadgeTech, Inc.

www.mccrometer.com

3255 WEST STETSON AVENUE • HEMET, CALIFORNIA 92545 USA	 Printed In the U.S.A.
TEL: 951-652-6811 • 800-220-2279 • FAX: 951-652-3078        	 Lit. # 30122-01,  Rev. 1.1 / 6-27-18

17



4.	 Enter the high reference value and the high device 
reading that will define the unit scale

5.	 Verify the information and click Write.

6.	 When the Reset Device window pops up, click Yes.

x x
x x

7.	 Once complete, click Close.

Setting Up the Engineering Unit
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8.	 Start device section.

9.	 Change the reading interval to the desired interval and 
select start.

10.	 Confirm devices status says running and the reading 
interval is at 12 hours.

Programming is now complete. 

Default 
12 hours

Setting Up the Engineering Unit
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8.2	 Creating and Selecting a New Unit of Measure

2.	 Fill in the Name, Description and Label (units must be 
in capitals) and hit Next. 

3.	 Select the High and low values option. 4.	 Fill in the low reference value, low device reading, high 
reference value, and the high device reading. Then click 
Next.

1.	 Beginning from the Create or Apply Engineering Unit 
screen, select the My unit isn’t listed option.

The example below shows entering a unit of acre feet, which is abbreviated as AFT. The values for your particular flow meter 
will vary.

NOTE: The engineering unit is the unit of measure the flow meter will measure water flow. To select and apply the 
engineering unit, you will need to know particular ratio of pulses per gallon for your flow meter. If you do not have 
that information contact McCrometer technical support.

Setting Up the Engineering Unit
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7.	 Once complete, click Close.

6.	 When the Reset Device window pops up, click Yes.5.	 Verify the information and click Write.

Setting Up the Engineering Unit
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9.0	 TROUBLESHOOTING
This section of the manual contains information that will help users answer questions to correct common connection 
missteps or other errors while using the software or devices.

WHY ARE MY DEVICES NOT APPEARING?

Sometimes a device connected to the computer does not appear in the Connected devices panel. This is often due to a 
minor connectivity issue. If a data logger does not show up in the Connected devices panel, or an error message is received 
while using a data logger, try the following:

1.	 Check that the interface cable is properly connected to the PC and the data logger. See section 7.0 for further 
details.

2.	 Ensure that the battery in the data logger is not discharged. For best voltage accuracy, use a voltage meter or 
multi-meter connected to the battery of the device. Alternatively, try swapping out the battery of a device that is 
connecting successfully, if one is available.

3.	 Ensure that no other data logging software is running.

4.	 Ensure that the Connected devices panel is large enough to display devices. This can be verified by positioning 
the cursor on the edge of the Connected devices panel until the re-size  cursor appears, then dragging the edge 
of the panel to re-size as necessary.

For more information:

•	 See the built-in Help menu.

•	 Watch the video tutorials at www.madgetech.com/software-download

TROUBLESHOOTING
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™FlowConnect

™DURA MAG

OTHER McCROMETER PRODUCTS INCLUDE:

Propeller Flowmeters

Di� erential Pressure Flowmeters

Wireless Monitoring System

Magnetic Flowmeters


